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1 Release Notes – Living Image 4.8.4  

1.1 Instruments  
Instruments affected include:  

• IVIS Lumina Series III/LT  

• IVIS Lumina XRMS  

• IVIS Lumina S5  

• IVIS Lumina X5  

• IVIS Spectrum 2 

• IVIS Spectrum  

• IVIS SpectrumCT 2  

• IVIS Spectrum CT  

1.2 Upgrade and Compatibility  
Upgradable software versions include:  

• Living Image 4.7.3  

• Living Image 4.7.4  

• Living Image 4.8.0  

• Living Image 4.8.1 

• Living Image 4.8.2  

• Living Image 4.8.3 

1.3 Release Objectives  
This is intended as an update providing an array of fixes for acquisition and analysis 
functionality with a most notable change that removes the licensing check for all users.  

1.3.1 New Features 
• Living Image no longer requires an activated license to run the main application 

or for plugins such as “3D Multi-Modality Tools” and “Spectral Unmixing and 
Dyce” 

• IVIS instruments installed with an Andor camera have a new acquisition option 
called "Camera Shutdown" to perform a controlled warmup prior to powering 
off an instrument 
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1.3.2 Improvements  
• Living Image can be launched by all standard users without administrator 

privileges.  

Note:  
Administrator privileges are still required to install the software.  

• More details are displayed when there is a problem with the specified account 
credentials associated with the auto background service 

• The Windows application installer utilizes Revvity branding 
• The registered trademark symbol (®) has been replaced with the trademark 

symbol (™) to clarify trademark status in various locations globally 
• Demand temperature information is included in the dark charge warning display 
• Float corrected photograph tif images are now saved when the user preference 

to save float corrected images is selected 
• Help->User Guide is now Help->User Manual to reflect the terminology used on 

the cover page of the included documents 
• Additional support added for galvos on older Spectrums as well as new 

Spectrum 2 Class instruments.  

1.3.3 Resolved Issues  
• Default X-ray image binning user setting contained an invalid option of "3" 
• X-ray "large animal" imaging position was not maintained across imaging 

sessions (IVIS Lumina XRMS only) 
• Living Image browser continued to show a previous dataset location filepath 

even after all data in the browser was cleared 
• Application installer failed to migrate the "emfilters" directory from the Caliper 

Life Sciences (LI 4.8.2 and earlier) location to the newer Revvity location 
• Applying user credentials for the Auto Background Service would overwrite any 

user defined start time of the acquisition 
• Applying a start time for the Auto Background Service would overwrite any user 

defined account credentials to use for the service 
• Spectrum CT instruments with a CameraLink interface failed to establish 

connection with the installed X-ray detector 
• Application failed to migrate the "config" directory from the Caliper Life Sciences 

(LI 4.8.2 and earlier) location to the newer Revvity location 
• IVIS Lumina machines with removable filter wheels failed to initialize following 

the selection of a new emission filter 
• Sometimes repeated clicks were unnecessarily needed to press "Create" and 

"Done" when creating a ROI using "Auto 1" 
• Total counts statistic for Spectrum CT datasets could be invalid due to an 

overflow error of a large value 
• The last frame of a Spectrum CT dataset was skipped during loading of the 

volume 
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• CT co-registration with optical data failed when using data acquired with Living 
Image 4.8.3 

• Auto Background service failed to start at configured time 
• Selecting the uninstaller option to restart the computer failed to initiate the 

restart 
• Various files in the Program Data directory on Windows failed to be cleaned up 

upon uninstalling Living Image 
• User preferences could not be saved successfully after upgrading from Living 

Image 4.8.2 or earlier 
• Camera cooling failed to start after application installation 
• Log files failed to save when running the application without elevated privileges 
• Application icon was missing in Windows installed programs list 
• Emission and excitation filter spectra plots failed to display in imaging wizard FLI 

probe selector dialog when multiple probes were selected 
• Named filters were not displayed in the imaging wizard emission filter plots 
• Save button was not enabled upon toggling Fluorescent Background Subtraction 

correction checkbox 
• Spelling mistakes were present in various locations of the user interface 
• Living Image crashed if an analysis-only install also had an acquisition specific 

CameraInfo.txt file present on disk 
• Warning message did not appear upon trying to do fluorescent imaging at FOV A 

using transillumination 
• Tooltips showing the emission and excitation filters in the spectrum plot of the 

imaging wizard were missing 
• Transillumination Head Homing Issue - When the transillumination head is at the 

extreme negative edges of travel, the homing routine does not work. This can 
lead to false positioning during transillumination scanning. See 1.5.1 below for 
details.  

1.3.3.1 Transillumination Head Homing Details  
If a power outage, or other interruption, occurs while the transillumination head 
position is at more than 66% of the allowed travel in either the negative X or Y direction 
(see diagram), the homing routine leaves the head incorrectly placed. This will lead to 
incorrect Fluorescent transillumination imaging locations.  

 
Figure 1. Transillumination Head 
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Detection and user warning: Living Image will now query the Firmware to report back 
the Transillumination head position after the homing routine. If the head is within an 
acceptable range of the home position (0,0: the cross hair in the diagram), then 
Acquisition continues as normal. However, if the reported (X,Y) position is outside of the 
acceptable range then the system reports an error, and the user is prompted to power 
cycle the instrument.  

Recovery steps: If the user is prompted to power cycle the instrument, the following 
steps describe how to do that:  

1. Remove the animal currently in the imaging chamber.  

2. Exit Living Image.  

3. Power off the instrument cabinet. Pressing the EPO switch will suffice.  

4. Wait 10-15 seconds.  

5. Power the cabinet back on (this will reset the UACC X and Y values to 
0,0 from the large stored negative values in the register).  

6. Launch Living Image and initialize the instrument.  

7. Start the Transillumination sequence.  

8. After the FLT point location photo, the transillumination head will be 
homed.  

1.4 Known issues and workarounds 
Description  Workaround  Severity  

On a Lumina X5, if you run an X-ray only sequence at 
a different FOV, there will be a scintillator to stage 
interference during the transitions between FOV.  

Add photograph to 
CT sequence.  

Major  

When acquiring a sequence with X-ray and the X-ray 
arm button is not pushed, the acquisition fails without 
warning.  

Scheduled for next 
version.  

Minor  

Surface Topography and DLIT/FLIT tool palettes go 
hidden for a newly acquired dataset if structure light 
acquisition fails for the next dataset in batch mode.  

Select Tool Palette 
from View menu.  

Minor  

Missing CT Target type in advanced preferences 
causes a crash. 

Close and relaunch 
Living Image. 

Minor 

Customers are reporting that Living Image 4 is also 
stopping when Emergency Stop is used. Correct 
behavior is that Living Image 4 should not stop.  

Launch Living Image 
again.  

Minor  
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1.5 Service Information 
• The installer and uninstaller of Living Image 4.8.4 are set to run as admin 

by default. This is for the smooth installation and uninstallation of auto-
background acquisition and cooler utility services. 

• For the machines in which camera cooler is disabled, the cooler utility 
service may still show as “Running” in windows services. The correct 
status will be available in the Activity Log and Cooler Activity log files. 

• On systems that have removable filter wheels, users must right-click on 
Living Image, select ‘Run as administrator,’ and then change the filter 
wheel for the removable filter wheel option to work properly. 

1.6 Technical & Product Documentation 
• User Manuals – Located in the Help menu of Living Image software. 

• Tech Notes – Located in the Help menu of Living Image software. 

• IVISense Fluorescent Probe Selector Guide pdf file - available as a 
desktop shortcut on the acquisition machines. 

2 Before You Begin 

2.1 System Requirements 
For optimum performance, Living Image software requires hardware and software that 
meet or exceed the requirements listed below.  

2.1.1 Computer Requirements 

Table 1. Analysis Workstation System Requirements 

Item Specification  

Operating System Windows 10, 11 
macOS 10.15+ 

RAM Minimum: 16 GB 
Recommended: 32 GB or greater 
64 GB for Spectrum CT datasets 

2.1.2 Graphics Card 
If you will be using the 3D Multi-Modality tools, the graphics card must meet the 
requirements below. 
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NOTE: 

If the GPU does not meet these specifications, the 3D multi-modality tools will not 
appear in the tool palette. 

Table 2. Graphics Card Requirements for 3D Multi-Modality Tools 

Item Specification 

OpenGL Version OpenGL 2.0 and above. 

OpenGL Extension GL_EXT_Texture3D 

Graphics Card Memory Minimum: 1GB (Dedicated) 

3 Installing Living Image Software on Windows 

3.1 Installing the Software 
Living Image software installs at the following location: 

LOCATION 

C:\Program Files\Revvity\Living Image 

1. Go to the In Vivo Imaging Software Downloads page. 

2. Under Living Image Software (IVIS Imaging Systems), click the link to 
download the Living Image installer for Windows. The installer file is 
in the form of LI<version>_WIN_64Bit_Install.zip. 

3. After the download is complete. 

a. Navigate to the installer zip file using Windows Explorer. 

b. Unzip the file. 

c. Right-click the unzipped installer file and click Run as 
administrator from the shortcut menu, then enter the local 
administrator’s username and password. The installation will 
begin. 

4. Choose a language and click OK on the Welcome screen that 
appears. The Introduction screen appears. 
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Figure 2. Living Image Software 

5. Review the introductory information and click Next. 

 
Figure 3. Introduction window 

 

6. Read the license agreement. To continue with the installation, 
accept the terms of the license agreement and click Next. 

 
Figure 4. License Agreement window 

 

7. If you are installing the optional 3D Multi-Modality and/or DyCE 
tools, choose these options in the Choose Install Set screen (Figure 
5). Click Next. The installation proceeds. 
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Figure 5. Choose Install Set 

8. Living Image software is now ready to install the standard analysis 
features.  

• Data Acquisition Module - Choose this option if you are 
installing the software on an acquisition workstation. 

• 3D Multi-Modality Module - Choose this option to install the 3D 
Multi-Modality tools. 

• DyCE Module - Choose this option to install the DyCE tools. 

9. Confirm that the installation information is correct, then click 
Install. 

 
Figure 6. Pre-installation Summary window 

 
Figure 7. Installing Living Image window 
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10. If the installer detects a previous Living Image installation (analysis 
or acquisition version), you will be prompted to confirm un-
installation of the earlier version.  

11. Click Yes in the confirmation message to uninstall the previous 
Living Image software and install the Living Image 4.8.4 software. 
Click No to terminate the installation program. 

NOTE: 

If older Living Image software is installed on the acquisition 
computer, the installer uninstalls the old software and copies all 
essential calibration files (CameraInfo.txt, CameraLog.txt, 
Background folder, LI_AutoBkgList.csv, Emfilters folder, 
FLReference folder, SLReference folder, CCDCal folder, if such 
exists) to the Living Image directory. 

NOTE: 

If the message shown below appears, click OK. The installation 
proceeds. 

 
Figure 8. Launch Anywhere Error message 

12. Click Done in the Install Complete screen after the installation is 
finished. When you see the message “System must be rebooted to 
complete the configuration”, reboot the computer right away or at 
a later time. 

 
Figure 9. Install Complete Window 

13. After successful installation on an acquisition computer, start the 
Living Image software and verify that you can initialize the IVIS 
Imaging System. If you are unable to initialize the imaging system, 
contact Revvity technical support. 
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14. If your computer is equipped with multiple graphic cards, please 
follow the next figure to default Living Image to use the highest 
performing graphics card for the Living Image software. Otherwise, 
the Living Image 3D viewer, especially with the 3D Multi-Modality 
tool, may not function correctly when running on low-end 
integrated graphics hardware. The image below shows an example 
of a laptop with both Intel integrated graphics and NVIDIA 
graphics. Open the NVIDIA control panel and click on “Manage 3D 
settings.” In the “Program Settings” tab, add the Living Image 
executable (livingimage.exe) as the program to customize and then 
set the preferred graphics processor to “High-performance 
NVIDIA processor.” 

 
Figure 10. Nvidia control panel 

3.2 Troubleshooting Installation 
If the error message shown below appears, it indicates that the 
installation cannot proceed due to limited user privileges. Click OK to 
cancel the installation. 

 
Figure 11. Windows Installer window-Error message 

 

To resolve this issue: 
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• Login with the Administrator user account and start the installation. 

OR 

• Right-click the unzipped installer file and click Run as administrator from the 
shortcut menu, then enter the local administrator’s username and password. 
The installation will begin. 

If installation does not proceed, please contact your IT department. 

4 Installing Living Image Software on macOS 

1. Copy the Revvity-macOS-installer-x64-4.8.4.pkg to the desktop. 

 
Figure 12. macOS installer package 

2. Double-click on Revvity-macOS-installer-x64-4.8.4.pkg from the 
workstation computer. The Welcome to Revvity Installer screen 
opens. 

3. If prompted, install Rosetta following the on-screen instructions. 

 
Figure 13. Rosetta Install window 

4. If prompted, sign into the admin account using the admin username 
and password. 
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5. Review the Welcome to Revvity Installer Screen and click Continue 
to continue installation 

 
Figure 14. Install Revvity Installer window 

6. Read the license agreement, click Continue. 

 
Figure 15. Software License Agreement window 

7. Click Agree to accept the license agreement. 

 
Figure 16. License Agreement window 

8. If you are installing the advanced feature Package 3D Multi-Modality 
or DyCE tools, choose these options in the Custom Install screen, 
click Continue. 
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Figure 17. Custom Install window 

9. In the Standard Install screen, review the information then click 
Install. 

 
Figure 18. Standard Install window 

10. Click Use Password. 

 
Figure 19. Use Password window 
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11. Enter your password in the Authenticate dialog box that appears and 
click Install Software to start Installation. The Installation window 
opens. 

 
Figure 20. Installing Software progress bar 

12. Review the Installation summary screen and click Close to complete 
the Installation procedure. 

 
Figure 21. Installation Completed window 

13. Verify the Living Image icon has been installed on the dock. 

 
Figure 22. Living Image Icon on the dock 
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5 Contact Revvity 

If you have a question about a product that is not answered in this manual, or if 
you need assistance regarding this product, please contact Revvity Technical 
Support Center at https://www.revvity.com/contact-us. 

6 Copyright 

This manual is published by Revvity, Inc., 77 4th Avenue, Waltham, MA 02451 USA on July 23, 2025 
10:39 AM. Copyright 2025, Revvity, Inc. All rights reserved, including but not limited to those rights 
to reproduce this publication or parts thereof. Reproduction of this publication or parts thereof, or 
the products it describes, by any means or in any form is expressly prohibited without the written 
permission of Revvity. 

7 Trademarks 

Revvity is a trademark of Revvity, Inc. All other trademarks are the property of their respective 
owners. 

8 Content 

Any errors or omission which may have occurred in this publication despite the utmost care taken in 
its production will be corrected as soon as possible, but not necessarily immediately upon detection. 
Revvity provides this publication “As Is” without warranty of any kind, either express or implied, 
including but not limited to the implied warranties of merchantability or fitness for a particular 
purpose. Some states or jurisdictions do not allow disclaimer of express or implied warranties in 
certain transactions; therefore, this statement may not apply to you. Revvity reserves the right to 
revise this publication and to make changes from time to time in the content hereof without 
obligation of Revvity to notify any person of such revision or changes. Further, Revvity may make 
modifications to the product described in this manual at any time without any obligation to notify 
any person of such modifications. 

https://www.revvity.com/contact-us
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